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Introduccion

Este ejercicio desarrolla un andlisis de deforestacion en la region de la Selva Lacandona
(México) empleando imdagenes satelitales de libre distribucion y software libre. Sobre las
imdgenes se ejerce la técnica de rotacién radiométrica y se evaliua una diferencia de NDVI
y NDSI entre las tomas. Los resultados determinan las zonas con ganancia y pérdida de
vegetacién y se representan en dos mapas temdticos. El desenlace de este tépico es la
difusion a los pobladores de la regidn, generando un beneficio en la toma acciones
preventivas o correctivas ante un inminente riesgo ecoldgico.

Objetivo

Evidenciar el cambio de uso de suelo en la regidn de la Selva Lacandona producto de
actividades econdmicas, por medio del procesamiento de imdgenes satelitales,
obteniendo la identificacién de la zona arbolada afectada.

Acciones y evaluacion

Parfiendo desde la segmentacion de sensores, se readliza la seleccion de imdagenes
adecuadas para ser procesadas con el propdsito de determinar las variaciones en el tipo
de suelo, como lo son las pérdidas y ganancias de Normalized Difference Vegetation Index
(NDVI) y Normalized Difference Soil Index (NDSI) para la region de la Selva Lacandona.
Finalmente, el andlisis y los resultados reflejan las zonas donde existen los cambios en el
paisaje y las zonas con mayor degradacién vegetal.

l. Antecedentes

Flora

La selva es el lugar con mayor diversidad arbolada en la Republica Mexicana, se estima
que en una hectdrea de la Selva Lacandona afloran 267 especies de plantas incluyendo
160 clases de drboles; entre las especies representativas encontramos plantas como las
orquideas, las bromelias, los helechos arborescentes, y drboles como la caoba, el palo de
rosa, la ceiba y el cedro.

Fauna

Estudios demuestran la presencia de aproximadamente 70 especies de mamiferos, como
el jaguar, el ocelote, el mono sarahuato y el mono arana; 306 especies de aves, como la
guacamaya roja, el tucdn real y el tucdn de collar; una gran cantidad de reptiles, como la
nauyaca, la boa constrictora y la coralillo; ademds de anfibios e insectos.

A su vez, si tienen identificados en peligro de extincién:

Mamiferos: el mono aullador, mono arafa, nutria de rio, jaguar, puma, ocelote, trigrillo,
yuagouarundi y el tapir.

Aves: guacamaya roja, dguila arpia, quetzal, tucdn de collar y el fucdn real.




Area protegida

De las 950 000 hectdreas aproximadamente que componen a la selva, se declard como
drea natural protegida una porcién de 330,000 hectdreas denominada la Reserva de la
Biosfera Montes Azules. En esta regién encontramos la mayor biodiversidad de la Selva
Lacandona. Ahi se desarrollan proyectos de conservacién de las especies prioritarias
(guacamaya, tapir, mono saraguato y cocodrilo de pantano), y hay dos estaciones
bioldgicas (Chajul y Tzendales) desde las que se estudia el estado de la selva.

Problemas que enfrenta

Contaminacion y deterioro del suelo
El uso de agroquimicos y pesticidas, cambio en el uso del suelo, monocultivos, pérdida en
la extincion de la selva por los incendios forestales y la tala inmoderada.

5Coémo afecta la Contaminacion del suelo?

Las especies pierden sus hogares y fuentes de alimento, como resultado las poblaciones
disminuyen paulafinamente generando un desequilibrio en la cadena alimenticia,
culminando en una alteracién del ecosistema.

Contaminacion y uso del agua

La basura acarreada por los rios proveniente de las poblaciones, arrojo de desechos
industriales que desembocan en fuentes de agua v la filtracién de quimicos utilizados en la
agricultura.

5Coémo afecta la Contaminacion del agua?

La disminucién de fuentes agua potable de la zona, extincién de especies acudticas y por
consecuencia, la pérdida de fuentes de alimentacion para humanos y animales.

Il. Software libre

Se refiere a la libertad de expresion que cuenta el usuario y la comunidad como lo es
ejecutar, copiar, distribuir, estudiar, cambiar y mejorar el aplicativo, no necesariamente a
un precio relacionado por el licenciamiento. Todo software libre tiene que contar con los
cuatro principios:

Libertad O: ejecutar el programa a conveniencia;
Libertad 1: acceder y estudiar el cddigo y el modo de trabajo del aplicativo;
Libertad 2: voluntad de redistribuir copias para el beneficio de ofros usuarios;

Libertad 3: decisién de modificar versiones realizadas por otro usuario.




Qgis

Especificaciones

Qgis 0 Quantum GIS como anteriormente se le conocia es una herramienta de sistemas de
informacion geogrdfica estd disponible para la mayoria de las plataformas comerciales
como son Windows, Linux, MacQOS, entre otfras. Es un proyecto original de OSGeo y en 2008
se lanzé la primera version.

Esta herramienta permite manejar archivos rdster y vectoriales de una manera grdfica,
incorpora el desarrollo de bibliotecas de GDAL que anteriormente solo estaban disponibles
para GRASS; QGIS mejora el manejo de GRASS debido a que resultaba complejo para
algunos usuarios su uso por ser una interfaz de programacién no grdafica en lenguaje Python.

En la actualidad Qgis se encuentra en crecimiento debido ala demanda del mercado por
aplicaciones relacionadas a sistemas de informacién geogrdafica de distribucion libre.

Descarga e instalacion
Direccion electrénica: http://www.qggis.org/es/site/

QGIS

Un Si de Informacio afica libre y de Codigo Abierto

L

QGIS 2.18 Released
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Figura 1. Pdgina principal del sitio Qgis

Al seleccionar la opcidon de “descargar ahora”, se despliegan las versiones que se
encuentran disponibles del aplicativo, las cuales se encuentran listadas (Figura 2).
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Figura 2. Pagina Qgis donde se despliegan todas las versiones disponibles, en rojo versiones a largo plazo

Existen lanzamientos periddicos de la plataforma, estos lanzamientos frecuentemente
presentan bugs o errores por lo que se recomienda descargar la version Lanzamiento de
largo plazo o version estable.

Al seleccionar la opcién deseada de acuerdo con el sistema operativo que se trabaja, se
descarga un "archivo ejecutable” el cual estd programado para la descarga e instalacion
del aplicativo (figura 3).
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Figura 3. Explorador de archivos en Windows 10, en rojo el archivo ejecutable de Qgis version 2.14

Finalmente, ejecutando este archivo el sistema operativo procederd a la instalacion del
software.

Instalacidon de Complementos

Asimismo, en cumplimiento a los principios establecidos en el software libre, Qgis engloba
complementos desarrollados por terceras partes. Cada uno debe ser buscado,
descargado e instalado individualmente; el proceso se realiza de la siguiente manera:




Ingresar al
modulo Plugins
-> Manage &
install plugins

A continuacién,
desplegard una
pantalla
emergente
(figura 5).

En la barra de
buUsqueda
“search” se
debe colocar
el nombre del
complemento

Indexado el
nombre, el
sistema arroja
las
coincidencias
(1); para ser
instalado se
debe presionar
sobre la
instruccion
“instalar” (2).

Instalados los
complementos
se alojan enla
seccion

Plugins -> Grass
(Figura 7)
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Figi.lru 4. Pantalla de inicio Qgis, en rojo barra de herramientas de complementos.
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Complementos utilizados
Para este ejercicio se instalaron los siguientes complementos:

o Grass

e Point sampling tool

e Semi-Automatic Classification Plugin
e TOA

I, Marco de Referencia

El drea de estudio es la regién de la Selva Lacandona, la cual se localiza en los estados de
Chiapas y Tabasco al sur de la Republica Mexicana; de acuerdo con la Comisidn nacional
para el conocimiento y uso de la biodiversidad (CONABIO) tenemos los siguientes datos:

Coordenadas exiremas: Latitud N: 16°04' 12" a 17° 26' 24"

Longitud W: 90° 22' 48" a 92° 02' 24"
Entidades: Chiapas, Tabasco.

Municipios: Altamirano, La Independencia, Las Margaritas, Ocosingo, Palenque,
Tenosique.

Localidades de referencia: Tenosique de Pino Sudrez, Tabasco.; Palenque, Chiapas.; Rio
Chancald, Chiapas.; San Juan Chancalaito, Chiapas.

\
_— 1

e CHIAPAS C

{
4

S

Figura 8. Imagen de los estados de Chiapas y Tabasco en rojo el perimetro conformado por las coordenadas
extremas.




IV. Tipos de Imagenes Satelitales y Descargas

Landsat

Sitio de descarga
https://earthexplorer.usgs.gov/

Especificaciones del sensor
Landsat 8

Numero de Banda um Resolucion
1 0.433-0.453 30m
2 0.450-0.515 30m
3 0.525-0.600 30m
4 0.630-0.680 30m
5 0.845-0.885 30m
6 1.560—1.660 30 m
7 2.100-2.300 30m
8 0.500-0.680 15m
9 1.360-1.390 30 m
10 10.6-11.2 100 m
11 11.5-12.5 100 m
Fecha de lanzamiento: 11 - 02 -2013
Ciclo Orbital: 16 dias. 233 orbitas
Landsat 7
Numero de Banda um Resolucion
1 0.45-0.515 30m
2 0.525 - 0.605 30m
3 0.63 - 0.69 30m
4 0.75 - 0.90 30m
5 1.55-1.75 30m
6 10.40 - 12.5 60 m
7 2.09-2.35 30m
PAN 52 -.90 15m

Fecha de lanzamiento: 15 -04 - 1999

Ciclo Orbital: 16 dias. 233 orbitas




Comparativa Landsat 7 y Landsat 8
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Figura 9. Grdfica comparativa de las bandas en los sensores Landsat 7 y Landsat 8 de acuerdo con la longitud
de onda en el espectro electromagnético.

Landsat-7 ETM+ Bands (um) Landsat-8 OLI and 77RS Bands (um)

30 m Coastal/Aerosol 0.435-0.451 | Band !
Band 1 30 m Blue 0.441-0.514 | 30 m Blue 0452-0.512 | Band2
Band 2 30 m Green 0.519-0.601 | 30 m Green 0.533-0.590 | Band3
Band 3 30 m Red 0.631-0.692 | 30 m Red 0.636-0.673 | Band 4
Band 4 30 m NIR 0.772-0.898 | 30 m NIR 0.851-0.879 | Band 5
Band 5 30 m SWIR-1 1.547-1.749 | 30 m SWIR-1 1.566-1.651 | Band 6
Band 6 60 m TIR 1031-12.36 | [00m TIR-1 10.60—11.19 | Band 10

100 m TIR-2 11.50-12.51 | Band 11
Band 7 30 m SWIR-2 2,064 -2345 | 30 m SWIR-2 2.107-2.294 | Band7
Band 8 15 m Pan 0.515-0.896 | 15 mPan 0.503-0.676 | Band 8

30 m Cirrus 1.363-1.384 | Band 9

Figura 10. Tabla comparativa de las bandas en los sensores Landsat 7 y Landsat 8 de acuerdo con la longifud de
onda en el espectro electromagnético.




Descarga de informacidn

Inicialmente, se debe seleccionar los criterios de buUsqueda (figura 11), es necesario
intfroducir la regién y el periodo en el cual se desean los resultados.

< > O |A e usgs.gov | = Z O

Home Save Criteria Load Favorite ~ Manage Criteria
ISl Datasets | Addtional Citeria || Results

1. Enter Search Criteria

—
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define your search area (for advanced map tools, view
the help documentation), and/or choose a date range
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Figura 11. PAgina principal de “earthexplorer”, en primera instancia se encuentran los criterios generales (lugary
tiempo).

A continuacién, seleccionar archivos (Data Set), lo cual se refiere al tipo de sensor que se
desea visualizar. En esta regidn se pueden seleccionar mds de una opcion (figura 12).
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Figura 12. Pagina principal de “earthexplorer”, Data Set Search seleccidn de sensor para la busqueda.




Adicionalmente, se puede agregar el nombre del archivo, la fila y columna, el ID del
sensor, la cobertura de nubes, el dngulo de toma entre otros (figura 13).
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Figura 13. Pagina principal de “earthexplorer”, Otros Criterios seleccién de busqueda avanzada.

Finalmente, el buscador despliega los resulfados de acuerdo con los criterios
seleccionados. Se puede apreciar una vista previa de la escena sobre el drea de
cobertura.
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Figura 14. Pagina principal de “earthexplorer”, Resultados y vista previa en rojo vista previa de la escena del
25/04/08.

Culminando el proceso, se debe presionar sobre el icono de descarga, continuamente este
despliega una ventana emergente listando las versiones disponibles. Sobre la ventana
emergente se selecciona Level 1 o Nivel 1 que corresponden a imdgenes multiespectrales
(figura 15).
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Landsatl ook Natural Color Image (8.5 MB)
| Landsatl.ook Thermal Image (5.7 MB)

| Landsatlook Images with Geographic Reference (17.2 MB)

| Level 1 Product (259.1 MB)

Figura 15. PAgina principal de “earthexplorer”, listado de versiones en rojo version Level 1 (multiespectral).

Descargadas las imdagenes, se alojan en la carpeta del explorador, dentro de un archivo
comprimido, para su frabajo es necesario realizar un proceso de descompresion.
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Figura 16. Explorador de archivos en Windows 10, en rojo el archivo comprimido Landsat 8 y Landsat 7.

Sentinel-2

Sitio de descarga
https://scihub.copernicus.eu/dhus/#/home




Especificaciones del sensor

Banda 2 - Blue 490 65
Banda 3 - Green 560 35
10
Banda 4 - Red 665 30
Banda 8 - NIR 842 115
Banda 5 - Vegetation Red Edge 705 15
Banda 6 - Vegetation Red Edge 740 15
Banda 7 - Vegetation Red Edge 783 20
20
Banda 8A - Vegetation Red Edge 865 20
Banda 11 - SWIR 1610 90
Banda 12 - SWIR 2190 180
Banda 1 - Coastal aerosol 443 20
60 Banda 9 - Water vapour 945 20
Banda 10 - SWIR - Cirrus 1380 30

Fecha de lanzamiento: 23 - 06 — 2015

Ciclo Orbital: 10 dias (1 satélite), 5 dias (2 satélites)




Comparativa Landsat 7, Landsat 8 y Sentinel-2

Comparison of Landsat 7 and 8 bands with Sentinel-2

g

Sentinel-2 msi

Landsat 8
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Figura 17. Grdfica comparativa de las bandas en los sensores Landsat 7, Landsat 8 y Sentinel 2 de acuerdo con la
longitud de onda en el espectro electromagnético.
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Landsat Sentinel-2

Number in series 7+1* starting with 2

Launch 1972 to 1999* S2-A launch end 2013
Measurement principle scanner pushbroom

Earth coverage 16 5 days
Swath 185 290 km
Multispectral bands 7(8%) 13

Spatial sampling 30,60 10, 20, 60 m

distance
* LCOM mission
targeted early 2013

Figura 18. Comparativa entre la familia Landsat y Sentinel (nUmero de series, lanzamientos, principio de medicion,
cobertura, ancho de toma, bandas, resolucién).

Descarga de informacion
Ir al sitioc web de la Agencia Espacial Europea (ESA) e iniciar sesion.

Figura 19. Pdgina de inicio de sesidn ESA




A continuacién, se debe seleccionar la regidn en el mapa donde se desea implementar la
busqueda de imdgenes. También, se puede escribir el sitio en el navegador y presionar
sobre el simbolo de la lupa (figura 19).
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Figura 19. P&gina ESA, en rojo drea seleccionada para la regién de la Selva Lacandona

El motor de busqueda despliega todas las imdagenes disponibles de la zona. Para ver los
atributos de cada una, es necesario sobreponer el puntero sobre la imagen deseada.
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Figura 20. Pagina ESA, en rojo listado de imdgenes disponibles de la regién de la Selva Lacandona




Finalmente, al seleccionar la imagen deseada, se despliega una ventana emergente, en
la cual se validan los atributos de la escena como es el drea de cobertura y una vista
previa, en el caso de que sean favorables a nuestro estudio se procede a la descarga.

S2A_MSILIC_20170105T162652_N0204_RO40_T15QYLl 20170105T162845

tps iscihu. coperiicus. u/anus/a0aIaN 1/Proal

Figura 21. Ventana emergente propiedades de la imagen seleccionada, en rojo botén de descarga.

V. Seleccidon de imdagenes apropiadas

La seleccién de imdgenes para este ejercicio se lleva a cabo por medio de discriminar
patrones que interfieran con el contenido de informacién que se desea extraer. La escena
debe tener una cobertura de toda la regidn de la selva.

Para las imdgenes Landsat 7 y 8 se tiene que la region de estudio estd en el path y row (fila
y columna) [021,048] y [021,049] y para las imdgenes de Sentinel-2 se encuentra en la orbita
R083. De los 3 sensores se buscan imdgenes que se encuentren dentro del periodo de
tiempo determinado que es de 2000 a 2013 y que no contengan mds del 30 % de nubes en
la escena, teniendo en cuenta que es una zona selvdtica y que la presencia de nubes es
habitual en estas tomas.

Habiendo prestado mucha atencidn a las imdgenes, se descartan las imdgenes Landsat 7
entre los anos 2003 a 2017 debido a la falla que existe en el mecanismo Scan Line Corrector
(SLC) y que provoca la falta de informacion en las tomas de aproximadamente 22% y para
este ejercicio seria necesaria una interpolacién de datos; asi mismo, se descartan las
imdgenes Sentiel-2 porque no existen tomas claras sin nubes de la regidn, producto de su
reciente lanzamiento por lo cual el acervo de imdgenes no es amplio.

Dicho y definido los pardmetros, se establece que los meses de abril y mayo son los idéneos
para trabajar debido al bajo porcentaje de nubes en la escena.

Con el objeto de evidenciar lo anterior, a continuacion, se muestran ejemplos de imdgenes
satisfactorias y no satisfactorias;




Imagen descartada, debido al
alfo porcentaje de nubosidad.

Ve

Figura 22. Imagen Landsat 8 [09/05/2016] P&R[21/48

Imagen aprobada, aunque
presenta nubosidad, no afecta
el drea de estudio.

L

Figura 23. Imagen Landsat 7 [19/04/2000] P&R [21/48]

Finalmente, en cumplimiento con los pardmetros, se seleccionaron cuatro archivos para
realizar el estudio:

Estas imdgenes son 2 escenas de Landsat 7

1. LE70210482000110EDCO00 con fecha de 19 de abril de 2000 y 2
2. LE70210492000110EDCO00O escenas de Landsat 8 con fecha de 01 de
3. LC80210482013121LGNO1 mayo de 2013; ambas cumplen con los
4. LC80210492013121LGNOT pardmetros deseados para el andlisis de

deforestacion.




VI. Tratamiento y Correcciones de Imagenes

Pre-procesamiento

Calibraciéon de numeros digitales a valores de radiancia y reflectancia

Los pixeles de las imdgenes satelitales se encuentran en un rango denominado niveles
digitales (DN), que son valores determinados por la cantidad de informacién que puede
almacenar, estos son de 8, 16, 32, ... bits dependiendo del tipo de sensor y contendrdn
valores en una escala de [0,255], [0, 65 535], [0, 4 294 967 295], y asi continuamente.

También conocido como modelo simplificado se emplea para reducir la variabilidad entre
escenas y consiste en la trasformacién de estos DN a valores de radiancia para después
obtener valores de reflectancia teniendo en cuenta los pardmetros como lo son fecha de
toma, dngulo zenital y distancia entre el Sol y la Tierra.

La primera parte de la calibracién Spectral Gain .-
consiste en transformar estos niveles radiance
digitales a valores de radiancia, para
esto cada sensor tiene informacién sobre
su Gain (pendiente) y Bias (ordenadal)
dependiendo de la banda. Utilizando la
siguiente férmula:

T Bias

. Digital number (DN) ~ 2>°

LWAX ., — LUIN 3
['/3 = = - x (Qca 7 Qn:' almin ) i LW[A A
k Q{:a] max Qc‘al min !
L, = TOA spectral radiance (/' / (11,'2 Sr /wii)

LMAX, = Spectral at-sensor radiance that is scaled to Qcatmax ( W/ (iﬁ2 sr ,um))

LMIN, = Spectral at-sensor radiance that is scaled t0 Qi (// /(ﬁ}2 sr Jum))

Q. = Quantized and calibrated standard product pixel values (DN)
Qummex = Maximum quantized and calibrated pixel value corresponding to LMAX; (DN)
Quatmin = Minimum quantized and calibrated pixel value corresponding to LMIN; (DN)

Después, es necesario transformar estos valores a reflectancia planetaria o albedo, esta es
la relacién entre el flujo incidente y el reflejado. Estos valores no cuentan con unidades; se
obtiene mediante la siguiente férmula:




r-L,-d’
ESUN, -cos @,

P, =

p, =reflectanc ia planetaria

L, =Radiancia espectral medida por el sensor

d =Distancia delSola la Tierra en unidades astrondmic as, mterpolad a
a partir deldia juliano dela toma de fecha de la escena

ESUN , =Promedio de irradianci a solar exoatmosf¢ rica para el sensor
6. = Angulo de elevacion solar

Esta transformacion unicamente unifica las diferencias de calibracion en las bandas de la
imagen y cambia la escala de medicion de un pardmetro biofisico. No se corrigen efectos
atmosféricos o por efecto de adyacencia de cubiertas cercanas.

Correccion por Nubes

Las nubes altas, delgadas o gruesas son dificiles de identificar en imdgenes satelitales. Las
nubes y la sombra que crean interfieren en los valores de medicién, por lo que Landsat 8
OLl cre6 una banda que ayuda a identificar estos objetos utilizando la informaciéon
espectral donde las nubes tienen una mayor respuesta.

El método de deteccidon de
nubes cirrus para Landsat 8
OLl se encuentra definido
por el siguiente criterio
utilizando Unicamente la
banda 9:

OLlo2 5245 6 poroa=0.00568

Figura 24. Imagen Landsat 8 de Nubes Cirrus OLls




Para localizar las nubes
comunes (distintas a nubes
cirrus) se utilizan las bandas
2y 4. La férmula a emplear
es la siguiente:

OLlc=0.846 x OLI2—0.46 x
Oll4
OLlc> 2458

Figura 24. Imagen Landsat 8 afectada por nubes OLlc

Para realizar la correccidon por nubes, se utiliza la siguiente ecuacién. De acuerdo con la
grdfica existe una relacion lineal entre los valores de niveles digitales DN y los valores que le

corresponden al OLlc (OLI cloud).

OLI,
OLI,
OLI,
OLI,
OLI,

OLT =

decloud

OLI, |

|1.88
10.89
11,02
10.85
11.40
071 |

x OLT

cloud

OLlcioud €5 el resultado de la ecuacién de OLllic y Ollnes el nUmero de banda que se estd

frabajando del sensor.

El resulfado es una imagen clara donde las nubes se reducen considerablemente, lo
apreciamos en las siguientes imdagenes (figura 25/26):




Figura 25. En color verdadero (RGB) sin Figura 26. En color verdadero (RGB) corregida
correccion

Cdlculos de Indices

NDVI

Este indice es calculado de acuerdo con la diferencia entre la banda del infrarrojo cercano
y el rojo; es un indice de vegetacién y al ser normalizado los valores que arroja se
encuentran entre [-1,1]; valores como rocas y construcciones tienen valores por debajo de.
0.1, la vegetacién arbustiva aproximadamente tiene valores de [0.2, 0.5] y la vegetacién
densa contara con valores superiores a 0.6

La férmula para calcular estos valores es:
_ (NIR - RED)
(NIR + RED)

La manera para generar estas operaciones es utilizando la calculadora raster que se
encuentra en Qgis -> Raster -> Raster Calculator.

NDVI

7 0GIS 2.14.7-Essen £ O >
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Figura 27. Barra de herramientas Qgis, en rojo se despliega el inciso de calculadora rdster




</ Raster calculator

Raster bands

LCBO210482013121LGNO1_B4@1
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Result layer
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(LC80210482013121LGNO1 BS@1" - "LCB0210482013121LGNO L B4@1") / ("LCB0210482013121LGNO1 BS@1” + "LCB0210432013121LGND L BA@1")

Figura 28. Ventana de calculadora rdster en Qgis, en este ejemplo para Landsat 8 se utilizan las bandas 4 y 5

NDSI

Es un indice normalizado para identificar suelos, dentro de estos la mayoria de las veces se
encuentran campos de cultivo y suelos desnudos. Para este andlisis, se decide comprobar
los resultados de NDVI contra resultados de NDSI. Esto indicaria que zonas tienen cambios
en el uso de suelo relacionado con la ganancia o pérdida de vegetacion reflejada. La
féormula para el cdlculo NDSI es:

NDSI = (SWIR - NIR) / (SWIR + NIR)

El método para el cdiculo se lleva a cabo con la calculadora rdster utilizando las bandas
adecuadas de acuerdo con el sensor utilizado siguiendo los pasos expresados (figuras 27 y
28).

Metodologia de deteccién de cambios

La técnica utilizada en este ejercicio es la rotacion controlada por un eje de no cambio. Lo
cual consiste en afirmar que los punfos de valores en la imagen, se consideran puntos en
un espacio cartesiano de ejes ortogonales; la variacién entre los efectos del cambio de
posicién entre las imdgenes puede ser:

e Cambios en las condiciones atmosféricas al momento de la toma de la escena lo
cual afecta a todos los puntos de manera homogénea.

e Cambios en la humedad vy tipo de cobertura del suelo que afectarian la dispersidon
en algunas zonas determinadas.

e Diferencias entre sensores y procesos de calibracién entre estos (Landsat 7 y 8).

La técnica produce una frasformacion lineal que genera una rotacion de los ejes
ortogonales del espacio, estos corresponden a los valores radiométricos en las escenas. En
este caso, los valores se encuentran normalizados debido al uso de NDVI y NDSI.

La rotacién se aplica con relaciéon a la pendiente formada por el eje de no cambio, el eje
representa los puntos de control que se tienen en campo; debido al método de
levantamiento de estos puntos de control, el error puede incrementarse o disminuir. En este




estudio, se colocaron puntos sobre el primer cuadrante de las ciudades principales y sobre
cuerpos de agua. El resultado de los indices calculados no se verd afectado, debido a la
poca respuesta espectral que tienen estos cuerpos dentro de las bandas involucradas.

*
Nueva Palestina

Figura 29. Imagen LS8 Bandas (5.4.3) se aprecia el poblado de Nueva Palestina y un punto de conftrol en el
centro.

El eje describe la relacién directa de los pixeles de no cambio entre las imdgenes de los
anos 2000 y 2013. El dngulo de rotacion (alpha) estd definido como el arco tangente de la
pendiente de la recta formada por los valores de no cambio; con base en el método
paramétrico, el cual es un modelo lineal para la resolucién de observaciones e incégnitas.

Los valores de las escenas NDVI de los dos anos se extraen utilizando la herramienta “point
sampling tool” un plugin de Qgis. Con estos valores se realiza el cdlculo de la pendiente.

Ecuacion de la recta de regresion de no cambio
FECHA, = m -FECHA, + Oi 1
a = arctg (m) (2)

Calculo de la Imagen deteccion
IDET= o FECHA] -sen o+ FECH‘AI ~COsS O (3)

FECHA, : NDVI / NDSI primera fecha
FECHA,; : : segunda fecha
m : pendiente de la recta de regresion

Oi : ordenada al origen de coordenadas

@ : angulo de rotacion

Energia mfiante Feoha #1 W] > Iper : Imagen deteccion de cambios

Energia radiante Fecha #2 [W/m2]

Figura 30. Grdfica de evaluacion de degradacidén/ganancia y las ecuaciones que generan el modelo.

Una vez calculada la pendiente y la ordenada al origen, se realiza la normalizaciéon de las
dos imdagenes para que se encuentren en el mismo sistema lineal. Finalmente, se aplica la
ecuacion 3 lget (figura 30) para el cdiculo de degradacidén y recuperacion entre las tomas.




Figura 31. Imagen P/R (021/048) Idet con valores [0.428048, -0.910851]

Como resultado se genera una nueva imagen lqet, Ia cual representa una deteccién de
cambios; para el sustento del ejercicio, expresa las diferencias radiométricas en la
vegetacién de la zona de estudio, de acuerdo con el nivel de los valores es el tipo de
cambio que existen en la zona.

Reclasificacion
Para este proyecto se clasificaron los cambios de la escena en 5 tipos:

Recuperacion media
Recuperacion fuerte
No cambio
Degradacién media
Degradacion fuerte

A

La reclasificacion se realiza utilizando el plugin de GRASS, este complemento cuenta
herramientas que permiten realizar diferentes tareas entre ellas reclasificar un archivo réster
de acuerdo con los pardmetros intfroducidos.
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Como lo muestra la grdfica, los resultados de la imagen se realizan utilizando una
distribucion normal para definir los rangos. La regidén de no cambio (gris), la determina los
nuevos valores de los puntos de control que se extraen de la escena lper de acuerdo con el
valor mdximo y minimo. Las regiones de recuperaciéon fuerte, recuperacién media,
degradacién media y degradacién fuerte son la diferencia entre la regién de no cambio y
el valor del borde de la escena lper dividido entre dos.

VIl. Datos vectoriales

Al igual que los archivos rdster generados, se necesita informacién vectorial para la
creacién de un mapa, ya que esta proporciona datos complementarios que son de suma
importancia. Esta informacién para la Republica Mexicana se encuentra en muchos sitios
web que son dependencias del gobierno federal.

En esta ocasidn los archivos que se requieren son limites estatales, limites municipales y
localidades urbanas.

Descarga de datos

INEGI
Sitio web: http://www.inegi.org.mx/default.aspx

Los datos se encuentran en Geografia -> Temas -> Cartografia Urbana
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Figura 32. PAgina Principal de INEGI, en rojo se despliega la ruta para de acceso a Cartografia urbana




ol W&
INSTITUTO NRCIONRL . e
DE ESTRDISTICA Y GEOGRAFIRA inicio | Contacto & | siguenos: 5 (3 B3 Wil

Esladistica~ Productos y Servicios + Acerca del INEGI + | m

Inicio = Geografia = Geoestadistica

Marco Geoestadistico Nacional

Marco Geoe

vatos vec e
Descarga. Contiene las siguientes capas de datos
* Areas Geoestadisticas Estatales (7.6 MB}
* Areas Geoestadisticas Municipales (37.8 MB}
* Poligonos de Localidades Urbanas Geoestadisticas (13.7 MB)

* Puntos de localidades Rurales (8.2 MB

Descarga.

Figura 33. Imagen Marco Geoestadistico donde se encuentran los archivos vectoriales
CONABIO

Sitio web: http://www.conabio.gob.mx/informacion/gis/
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Figura 34. Pagina principal CONABIO SIG

Para descargar informaciéon de este portal solo es necesario ir a la seccidn que se
pretende dentro del arbol desplegado.
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Figura 35. P&gina principal CONABIO, se despliega el drbol para informacién de division politica estatal

Procesamiento de Datos

Cambio de Proyeccion y Datum

Los archivos descargados de portales de instituciones gubernamentales nacionales estdn
en el Datum oficial de México el cual es ITRF92 — 2010 y de es posible que se encuentren en
distintas proyecciones. Teniendo en cuenta lo anterior, para que el software pueda trabajar
de manera ideal, se necesita que toda la informacidn se encuentre en la misma proyeccion
y datum; las imdgenes descargadas Landsat se encuentran en la proyecciéon UTM Z15 y
datum WGS84 por lo que es necesario transformar los archivos provenientes del INEGI a este
datum y proyeccién debido a la conveniencia de trabajar en unidades métricas y que es
la unidad de la proyeccion UTM.

Para realizar esta operacion en Qgis es necesario visualizar el menu de opciones en la capa
y seccionar guardar como. se desplegard un cuadro y es necesario cambiar la opcién de
CRS.
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Figura 36. Pantalla de inicio Qgis, en rojo menu de “Guardar Como” desplegado




Recorte de datos

Para filtrar solo la informacién del drea de estudio se tiene que realizar un recorte de datos
vectoriales. Esto para eliminar datos dentro de los shapes que no son Utiles para el estudio.
Para esta accién se utiliza la herramienta de Clip la cual se encuentra en Vector ->
Geoprocessing Tools
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Figura 37. Pantalla de inicio Qgis, en rojo se observa el drea de estudio y en verde los municipios de la regién

Finalmente, el resultado es un recorte de la informacién del drea de estudio:
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Figura 38. Pantalla de inicio Qgis, en rojo se observa el drea de estudio y en morado los municipios de la zona de
estudio.




Resultados
Normalized Difference Vegetation Index (NDVI):

Deteccién de cambios utilizando técnicas de rotacidn radiométrica en la regién de la Selva Lacandona para medicion de deforestacion
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Figura 39. Imagen NDVI escala 1:250 000 para una impresién en 90 x 60 cm.




Se tiene la siguiente informacién de acuerdo con la superficie afectada estudiada a

tfravés NDVI:

KILOMETROS CUADRADOS

1.000.00 0.19 3.42 ]
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Ganancia Ganancia NG cambio Pérdida Pérdida
Fuerte Media media fuerte

ETotal 0.19 3.42 1,043.16 5,945.85 8.630.33

Figura 40. Grdfica de superficie acumulada NDVI en relacién con la superficie,

Tipo de cambio Porcentaje

Ganancia Fuerte 0.00%
Ganancia Media 0.02%
No cambio 6.68%
Pérdida media 38.06%
Pérdida fuerte 55.24%
Total 100.00%

Figura 41. Tabla de porcentaje con respecto a la superficie acumulada,

Por lo tanto, es evidente que la regidon ha perdido vegetacion, el mayor peso recae en
una pérdida fuerte, la cual se debe a un aumento en las actividades econdmicas (tala,
siembra, ganaderia).

En la zona norte, comprendida por los municipios de Balancan, Tenosique, Emiliano Zapata
y La Libertad sufre pérdidas menores en cuanto a vegetacion; esta region ha sido utilizada
histéricamente por la industria cafetalera y la cosecha de otros frutos en el estado de
Chiapas (figura 39).

Se aprecia una degradacidon media en un primer perimetro de las poblaciones y existe
una degradacion fuerte en un segundo perimetro que se extiende por toda la zona de
estudio (figura 42 y 43).
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Figura 42. Poblado Nueva Palestina, Municipio de Ocosingo, en la cual se aprecia una degradacion media en
el circulo interior y una degradacién fuerte en un segundo perimetro.
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Figura 43. Poblados Venustiano Carranza y El Triunfo, Municipio La Independencia; La Esperanza y Ldzaro
Cdrdenas, Municipio La Trinitaria. Se observa una degradacién media en el primer perimetro de todas las
localidades.
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En los cuerpos de agua, se observa una ganancia vegetativa, lo cual indica evaporacion

producido por la reduccion de los lagos y lagunas, generando vegetacion en dreas antes
ocupadas por agua(figura 44).
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Figra 44. Laguna de Miramar, extensidn de 16 km2, en azul zonas de ganancia v
ribera.




Normalized Difference Soil Index (NDSI):

Deteccion de cambios utilizando técnicas de rotacion radiométrica en la region de la Selva Lacandona para medicion de deforestacién
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Figura 45. Imagen NDSI escala 1:250 000 para una impresién en 90 x 60 cm.
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Figura 46. Grdéfica de superficie acumulada NDSI en relacién con la superficie,

Tipo de cambio Porcentaje

Ganancia Fuerte 0.01%
Ganancia Media 8.00%
No cambio 89.91%
Pérdida media 1.92%
Pérdida fuerte 0.16%
Total 100.00%

Figura 47. Tabla de porcentaje con respecto a la superficie acumulada,

Se observa una
ganancia media de
suelos desnudos en la
region central, en
otras palabras, una
degradacioén
vegetativa; la zona
afectada es la
superficie con mayor
altura de la selva, la
cual es una zona de
dificil acceso para su
proteccién.

Figura 48. Acercamiento a los municipios de Ocosingo, Altamirano y Las
Margaritas, en azul la ganancia media de suelos desnudos.




VIII.

Conclusiones

Analizando las imdgenes, la pérdida de vegetacion es grave en la region de La
Selva Lacandona por lo que se concluye que requiere una mayor atencion por
parte de las autoridades, apoyados por un seguimiento desde modelos apoyados
por técnicas de percepcidén remota.

Se cumplié el objetivo, el cual fue identificar las zonas de tala y el cambio de uso de
suelo que existen en la Selva Lacandona; utilizando percepcion remota, software
libre e imagenes de libre acceso.

Como plan a futuro, se propone un proyecto que continle este estudio,
incorporando software de licencia e imdgenes que contengan una mayor
resolucion espacial, con la finalidad de dar una vision mas detallada de la region.
Las imagenes con un tamano de pixel entre 1 y 5 metros permitirdn apreciar el
crecimiento de las comunidades y construcciones aisladas indetectables para un
pixel de 30m expresado en este estudio. La colocacion de puntos de control en sitio
con equipo GPS sobre edificaciones que no han sufrido modificacion en el tiempo
es necesario para minimizar el error en este estudio futuro.
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